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MPLAB®解析ツールスイート ユーザガイド 

開発ツールユーザへの注意

Important: 
どのような文書でも内容は時間が経つにつれ古くなります。本書も例外ではありません。Microchip
社のツールとマニュアルは、お客様のニーズを満たすために常に改良を重ねており、実際のダイアロ

グやツールの内容が本書の説明とは異なる場合があります。最新 PDF 文書は Microchip 社のウェブサ

イト(www.microchip.com/)をご覧ください。

文書は各ページ下部に表記している「DS」番号で識別します。DS 番号のフォーマットは DS<文書番

号><リビジョン>です。<文書番号>は 8 桁の番号、<リビジョン>はアルファベットの大文字です。 

最新情報はツールのヘルプ(onlinedocs.microchip.com/)をご覧ください。 

注意: この日本語版文書は参考資料としてご利用ください。 
最新情報は必ずオリジナルの英語版をご参照願います。

https://www.microchip.com/
https://onlinedocs.microchip.com/
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1. はじめに 
MPLAB 解析ツールスイートは、MPLAB X IDE と統合された解析ツールの集まりで、Microchip 社の MCU、MPU、

CEC、DSC の全デバイスをサポートします。MPLAB® Code Coverage と MISRA® (Motor Industry Software 
Reliability Association) Check を IDE に備えています。 

MPLAB Code Coverage 機能はコードのどの部分が実行されているかを表示します。IDE の MISRA Check は安全

でセキュアかつ移植可能で信頼性の高い C コードを組み込みシステムで保証するためのガイドラインを提供します。 
 
 
1.1 ライセンス 

MPLAB 解析ツールスイートのライセンスは microchipDIRECT のウェブサイトからご購入頂けます。MPLAB 解析

ツールスイートのライセンスは以下の通りです。 
• MPLAB 解析ツール ワークステーション ライセンス 

製品番号: SW006027-2 www.microchip.com/en-us/development-tool/SW006027-2 
• MPLAB 解析ツール HPA (High Priority Access)ワークステーション ライセンス 

製品番号: SW006027-2H www.microchip.com/en-us/development-tool/SW006027-2H 
• MPLAB 解析ツール ネットワーク サーバライセンス 

製品番号: SW006027-2N www.microchip.com/en-us/development-tool/SW006027-2N 
• MPLAB 解析ツール HPA ネットワーク サーバライセンス 

製品番号: SW006027-2NH www.microchip.com/en-us/development-tool/SW006027-2NH 

ライセンスは microchipDIRECT でご購入頂けます。 

https://www.microchip.com/en-us/development-tool/SW006027-2
https://www.microchip.com/en-us/development-tool/SW006027-2H
https://www.microchip.com/en-us/development-tool/SW006027-2N
https://www.microchip.com/en-us/development-tool/SW006027-2NH
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2. MPLAB Code Coverage 
 
2.1 MPLAB Code Coverage の概要 

MPLAB 解析ツールスイートの MPLAB® Code Coverage 機能はコードのどの部分が実行されているかを表示します。

カバレッジを視覚的に表示するためにテストケースを完了まで実行します。[AoU-09-COV]を参照してください。 

MPLAB Code Coverage 機能には以下のツールが必要です。 

• MPLAB XC8 v2.35、MPLAB XC16 v2.0、MPLAB XC32 v4.0 で始まるコードカバレッジ出力をサポートする

Free または PRO の MPLAB XC C コンパイラ。[AoU-02-COV]を参照してください。 
• コードのどの部分が実行されているかを表示する Code Coverage(1.1「ライセンス」参照)を含む MPLAB 解析

ツールスイート。[AoU-05-COV]を参照してください。 
• MPLAB 解析ツールスイート ライセンスで MPLAB XC C コンパイラからのコードカバレッジ データの表示を

サポートする MPLAB X IDE v6.0 以降。[AoU-04-COV]を参照してください。 

Note: 本書の内容は MPLAB X IDE v6.0 以降を想定しています。  

Note: MPLAB X IDE を使うと、コードカバレッジの機能を最大限に活用できます。  

コードカバレッジは MPLAB X IDE で以下のように表示されます。 

• コードカバレッジを表示したテキスト(緑=実行、黄色=部分的に実行、赤=未実行)。 
• コードカバレッジを表示したプログラムメモリ。 
• カバーされたコードの割合を色で表示するレポートを含む[Code Coverage]タブ。この情報は、後で表示でき

るように HTML レポートに書き出す事ができます。 
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図 2-1 Code Coverage - エディタ ウィンドウと[Code Coverage]タブ 
 

図 2-2 Code Coverage – [Program Memory]ウィンドウ 
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2.2 安全環境での MPLAB Code Coverage の使用 
 

Attention: 安全環境で MPLAB 解析ツールスイートを使うには、機能安全バージョンの Microchip 社製

コンパイラを使う必要があります。MPLAB 解析ツールスイートをサポートするコンパイラの新しい機

能安全バージョンはまだ利用できない可能性があります。適切な機能安全コンパイラのライセンスは

www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-
safety を参照してください。 

• MPLAB XC8 機能安全ライセンス(MPLAB 解析ツールスイート サポート付き) 
• MPLAB XC16 機能安全ライセンス(MPLAB 解析ツールスイート サポート付き) 
• MPLAB XC32 機能安全ライセンス(MPLAB 解析ツールスイート サポート付き) 

 
MPLAB Code Coverage は Microchip 社の開発ツールの標準的なプロセスに従って設計されています。Microchip 社

は、システムレベルで技術および機能安全要件を満たすためにツールに特定の AoU(使用前提条件)を主張します。

AoU については以下で説明します。これらの AoU のいくつかは本書の他のセクションで言及されており、説明し

ているトピックの一部として扱われています。 

システム インテグレータは本書に記載されている全ての AoU に対処し、MPLAB Code Coverage で解析するアプ

リケーションに関わる全ての構成要素または事項がこれらの AoU を確実に遵守する責任を負います。 

システム インテグレータには以下の 2 つの選択肢があります。 

• 各前提条件を満たしている事を確認する 
• 前提条件を無視する 

どちらの場合も、システム インテグレータは、前提条件を満たしている証拠、前提条件を無視しても安全要件には

違反しない理由、または別の方法で前提条件に十分対処している場合はその方法の詳細な説明を提供するものとし

ます。 

Microchip 社がコンパイラの機能安全バージョンと共に提供した分類基準書に記載されているように、MPLAB 
Code Coverage ツールは TCL 1 に分類されます。この分類は、FMEA で提示された使用前提条件とユースケースに

基づいています。 

表 2-1 義務の程度 
 

Shall(当然の義務。～するものとする) Binding(拘束力がある) 

Should(義務に近い強い推奨。～すべきである) 推奨する解決策 
 

使用前提条件 説明 

[AoU-01-COV] 本ツールのユーザは裏付けとなるデータソースまたは手法を提示するものとする。 

[AoU-02-COV] MPLAB Code Coverage ツールは、サポートされている機能安全バージョンの MPLAB XC コ

ンパイラと組み合わせてのみ使うものとする。 

[AoU-03-COV] Code Coverage は真正な機能安全プロセスと組み合わせて使うものとする。 

[AoU-04-COV] Code Coverage は適合するバージョンの MPLAB X IDE で使うものとする。 

[AoU-05-COV] Code Coverage のユーザは有効なライセンスを有しているものとする。 

[AoU-06-COV] Code Coverage は開発およびデバッグ時にのみ使うものとし、エンドユーザが運用中のアプ

リケーションでは使わないものとする。 

[AoU-07-COV] Code Coverage は管理下にある安全なテスト環境以外では使わないものとする。 

[AoU-08-COV] Code Coverage は、サポートされている Microchip 社製マイクロコントローラおよび DSC で

のみ使うものとする。 
[AoU-09-COV] テストを最後まで実行し、アプリケーションを静止状態にしてからコードカバレッジ デー

タを確認および解析するものとする。 

https://www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-safety
https://www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-safety
https://www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-safety
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2.3 MPLAB Code Coverage の詳細 
コードカバレッジの出力を表示するには、コードカバレッジをサポートする MPLAB XC C コンパイラおよび

MPLAB X IDE バージョンで MPLAB Code Coverage ライセンスを使います。[AoU-02-COV]、[AoU-04-COV]、
[AoU-05-COV]を参照してください。 

MPLAB Code Coverage は、C ソースコードからビルドされたものであればどのようなものとも動作します。色が

付いていない C ソースコードは実行可能イメージの中に存在しないものです。カバー済みにも未カバーにもカウン

トされません。例えば、よく見られる「while(TRUE)」文が実行可能な命令を生成する事はありません。 

MPLAB Code Coverage は MPLAB X IDE がサポートする全てのデバッグツールでサポートされています。 

コンパイラの動作 

コードカバレッジは MPLAB XC C コンパイラの計装機能によってサポートされています。このコンパイラはプロ

グラムメモリに最小限のコードを追加して RAM 上のフラグを更新し、カバレッジを示します。開発終了時にアプ

リケーションからこのコードを削除するには、2.5「コードカバレッジの有効化/無効化」に従ってコードカバレッ

ジを無効化してアプリケーションを実行します。これにより、フィールドで動作している製品からコードを確実に

削除できます。[AoU-04-COV]を参照してください。 

Note: コードカバレッジは ELF のみです。 

MPLAB X IDE の動作 

本 IDE は、ハイライト表示されたカバー済みコードを表示し、プロジェクト ファイルのカバー済みコードの割合を

表示します。ファイルのプロパティを設定する事でカバレッジに含めるファイルを選択できます。2.7.2.3.「プロ

ジェクト ファイルごとのコードカバレッジ」を参照してください。 

カバレッジのレポートも生成できます。2.8「コードカバレッジ HTML レポートの作成」を参照してください。 
 
 
2.4 ソフトウェアの入手 

コードカバレッジを使うには以下のツールを入手する必要があります。 

MPLAB X IDE 

MPLAB X IDE はバージョン v5.25 からコードカバレッジ出力の表示をサポートし、v5.30 で機能を追加しました。

ただし、MPLAB X IDE v6.0 のコードカバレッジの場合、MPLAB 解析ツールスイートのライセンスに MISRA 
Check が付属しています。[AoU-04-COV, AoU-05-COV]を参照してください。 

本 IDE は www.microchip.com/mplab/mplab-x-ide で無償ダウンロードできます。 

MPLAB XC C コンパイラ 

MPLAB 解析ツールスイートのライセンスは、コードカバレッジをサポートする全ての MPLAB XC C コンパイラ

(Free および PRO)で使用できます。[AoU-02-COV]を参照してください。 

サポートは以下のバージョンで開始されます。 

• MPLAB XC8 v2.35 
• MPLAB XC16 v2.0 
• MPLAB XC32 v4.0 

MPLAB XC C コンパイラは www.microchip.com/mplab/compilers でダウンロードできます。 

MPLAB 解析ツールスイートのライセンス 

MPLAB 解析ツールスイートのライセンスは他のコンパイラのライセンスと同じように購入してアクティベートで

きます。詳細は『MPLAB® XC C コンパイラのインストールとライセンス認証』(DS50002059)を参照してください。

[AoU-05-COV]も参照してください。ライセンスの製品番号は 1.1「ライセンス」を参照してください。 

ライセンスはそのコンピュータ上にある全ての MPLAB XC C コンパイラで有効です。このライセンスは Free およ

び PRO コンパイラで使用できます。 
 

https://www.microchip.com/mplab/mplab-x-ide
https://www.microchip.com/mplab/compilers
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2.5 コードカバレッジの有効化/無効化 
既定値では MPLAB Code Coverage は無効です。コードカバレッジを有効にするには、以下の手順を実行します。 

[Project Properties]ダイアログを開くには、[Tools] > [Analysis] > [Code Coverage]を選択するか、[Projects]ウィン

ドウでプロジェクトの名前を右クリックして[Projects]を選択する。 

1. [Categories]で[Analysis]をクリックする。 
2. [Option categories]の [General]を選択し、 [Code Coverage Instrumentation]で希望の項目を選択する。

MPLAB XC コンパイラによって選択内容は異なる(下表を参照)。 

表 2-2 コンパイラごとのコードカバレッジ有効化オプション 
 

MPLAB XC C 
Compiler 

有効化オプション 説明 

XC8 Disable コードカバレッジを無効にします。 

Enable コードカバレッジを有効にします。 

XC16 Disable コードカバレッジを無効にします。 

Enable Near memory コードカバレッジ機能に near RAM 空間を使います(推奨)。 
リンクエラーが発生した場合、far RAM を選択します。 

Enable Far memory コードカバレッジ機能に far RAM 空間を使います。 

XC32 Disable コードカバレッジを無効にします。 

Enable コードカバレッジを有効にします。 
 

図 2-3 コードカバレッジのオプション - MPLAB XC16 の例 
 

 

2.6 コードカバレッジ出力の表示 
2.5「コードカバレッジの有効化/無効化」の説明に従ってコードカバレッジを有効にしたら、コードをデバッグし

て全てのテストケースを最後まで実行します。その後、自動または手動で実行を停止し、全てのコードの実行が

完了するまで必要に応じた手順を実行します。 
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コードカバレッジを確認するには以下の手順を実行します。 

• プロジェクト名を右クリックして[Show Code Coverage Summary]を選択するか、[Window] > [Debugging] > 
[Code Coverage]を選択する。 

• エディタ ウィンドウでハイライトを表示する前に、必要に応じてそのウィンドウをクリックしてアクティブに

する。カバー済みコードがウィンドウでハイライト表示される。 
• [Program(または Execution) Memory]ウィンドウでハイライトを表示するには[Windows] > [Target Memory 

Views]でウィンドウを開く。カバー済み命令がウィンドウにハイライト表示される。 
• サマリレポートが[Code Coverage]タブに表示される。 

図 2-4 MPLAB X IDE でのコードカバレッジ 
 

 
2.6.1 ハイライト色 

下表に、エディタ ウィンドウと[Program(または Execution) Memory]ウィンドウのハイライト色の意味を示します。 
 

ハイライト色 ハイライト名 意味 
 

 緑 カバー済みで実行済み 

 

 黄 カバー済みで部分的に実行済み(エ
ディタ ウィンドウのみ) 

 

 赤 カバー済みだが未実行 

 色なし カバレッジ情報を未生成 1 
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...........続き 
ハイライト色 ハイライト名 意味 

Note 1: カバレッジ情報が生成されない理由として以下のものがあります。 
• 一部の C 構文が C ソース行に対応したコードを生成しない可能性がある 
• 最適化が C ソース行に対してコードを生成しない可能性がある 

C ソース行が実行可能なコードを生成しないその他の状況も考えられます。2.7「コードカバレッジ出力の内容」

の例を参照してください。 
 

2.6.2 カバレッジ色 
[Code Coverage]タブの[Coverage]の下にあるバーグラフの色の意味を以下に示します。 

 

カバレッジ色 カバレッジ名 意味 
 

 緑 テストスイートでカバーされて実行

されたコードの合計 
 

 赤 テストスイートでカバーされたコー

ドの合計 
 

このタブの詳細は 2.7.1.2.「[Code Coverage]ウィンドウ」を参照してください。 
 

2.6.3 [Code Coverage]タブのボタン 
このタブのガーターにあるボタンをクリックすると、以下の機能を利用できます。 

 
 

 
Generate HTML Report。このレポートは[Code Coverage]ウィンドウと同じデータを表示しま

す。 
 

 
エディタ ウィンドウでハイライト色表示を切り換え(有効化/無効化)ます。 

 

 
コードカバレッジを有効/無効にするために[Project Properties]を開きます。 

 
 
2.7 コードカバレッジ出力の内容 

以下では、IDE の各種表示が示すコードカバレッジの内容を詳しく説明します。 
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2.7.1 デモ サンプルコード 
図 2-5 エディタ ウィンドウ - デモ サンプルコード 

 

PIC24FJ128GA010 PIM 用の Explorer 16/32 ボード(www.microchip.com/DM240001-2)のデモコードを使用しまし

た。 

2.7.1.1 デモコードとカバレッジの色 
表示されている case '\n'文の内容を示します。 

• if 文の両方の条件が実行済みのため、緑(カバー済みで実行済み)で表示されます。 
• 両方の if 文が false と評価されたため、それに続く関数が赤(カバー済みだが未実行)で表示されます。 
• 2 番めの if 文の else が該当するため、それに続く関数が実行されて緑で表示されます。 
• case 文の break が黄色つまり部分的にカバー済み(カバー済みだが部分的に実行済み)として表示されていま

す。これは両方の if 文が実行済みの状態で予期しない事態と考えられます。部分カバレッジで何が起こって

いるのかを把握する場合、[Program Memory]ウィンドウの表示内容が役に立ちます。 

https://www.microchip.com/DM240001-2
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図 2-6 Program Memory - デモ サンプルコード 
 

上図のビューを表示するには、以下の手順を実行します。 

• コード実行を停止する。 
• [Program Memory]ウィンドウを開く([Window] > [Target Memory Views] > [Program Memory])。 
• エディタ ウィンドウで case '\n'の 2 番めの if 文にブレークポイントを配置する。 
• コード実行がブレークポイントの位置で一時停止するまでデバッグする。 
• [Step Into]を 1 回実行する。 

[Program Memory]ウィンドウで else 節と break 文の命令を確認できます。コンパイラは、関数呼び出しからの

ジャンプバックと case ループからのジャンプアウトを 1 つのジャンプにまとめています。これにより、break 文

がループに関連付けられます。従って、true を表す if 文の条件は実行されなかったため、黄色で表示されます。 

[Program Memory]を参照すると、行が部分的にカバーされている(黄色で表示)理由を把握できます。通常、赤い行

(カバー済みだが未実行)をなくすようにテストコードを記述する事で一部カバー済みの行を最小化できます。残り

の黄色の行は[Program Memory]ウィンドウのアセンブリで確認できます。 
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2.7.1.2 [Code Coverage]ウィンドウ 
[Code Coverage]ウィンドウを開くには[Window] > [Debugging] > [Code Coverage]を選択します。このウィンドウ

は、テストコードがアプリケーション コードをどの程度カバーできたかを表示します。 

コード実行が停止すると、アプリケーション内のファイルごとに現在のカバレッジ率が表示されます。矢印をク

リックすると、ファイル内の関数のカバレッジの内訳が表示されます。 

カバレッジはアドレス単位で表します。アドレス単位は、プロジェクト デバイス アーキテクチャの実行部分に

よってアドレス指定可能なメモリの最小単位を表します。 

カバレッジ率(緑)は x/(x+y)を表します(x はカバーされたアドレス単位、y はカバーされていないアドレス単位)。 

図 2-7[Code Coverage]ウィンドウ 
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2.7.2 単純なサンプルコード 
図 2-8 エディタ ウィンドウ - 単純なサンプルコード 

 

単純な C コード構造をコードカバレッジのデモに使いました。 

2.7.2.1 単純なコードとカバレッジの色 
色なし - カバレッジデータなし 

いくつかの C コード構造は実行可能なコードを生成しないため、ハイライト表示はありません。その例を以下に示

します。 

• プリプロセッサ宣言 - #include 文 
• 変数宣言と初期化 
• コメントまたはコメントアウトされたコード 

緑 - カバー済みで実行済み 

ある行の完全なカバレッジはその行のコードが完全に実行された時に発生します。 

main()関数は完全に実行されて戻るため、開始行、戻り行、終了行は完全なカバレッジを示します。 
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No source code lines were found at current PC 0x330. Open program memory view to see 
instruction code disassembly. 

if 条件を満たさないため、break 文を除いて for ループの行が全て最後まで実行されます。ループと条件文では 1
つまたは複数の条件または分岐があり、完全なカバレッジを得るにはそれらを全てテストする必要があります。 

calcAdd()等の 1 行で呼び出されて完了する関数も完全にカバーされます。 

黄 - 部分カバレッジ 

ある行のコードがカバー済みだが一部のみ実行済みの場合、部分カバレッジと見なされます。 

単純な if 文のため、a<b の評価は実行されますが、j=1 の代入は実行されません。従って、この行は部分カバ

レッジとなります。文が別の行にある場合、以下のように表示されます。 
 

if-else 文はバイナリロジックを使って分岐条件を決定します。選択した変数値により、この文は部分的にのみカ

バー済みです。a が 0 以外の値を持つ時に b は評価されないためです。 

赤 - カバー済みだが未実行 

前述のように、ループおよび条件文では、1 つまたは複数の条件または分岐があり、完全なカバレッジを得るには

それらを全てテストする必要があります。 

for ループの if 文は決して true にならないため、それに続く break 文は実行されません。 

if-else 文の条件が評価されるため、else 分岐は選択されず、それに続く calcSub()を含む行は実行されませ

ん。 

2.7.2.2 エディタでのカバレッジの制限 
エディタ ウィンドウは C コードの行を表示します。C 言語は高級言語であり、デバイスによっては C コードの 1
行で 1 つまたは複数のデバイス命令を表す事ができます。そのため、表示されたカバレッジの理由を決定するには

[Program(または Execution) Memory]ウィンドウで実際のデバイス命令を確認しなければならない事があります。 

例として、コード中でコメントアウトされている while(1)ループがあります。非コメント化してプログラムを再

度実行してから一時停止した場合、[Output]ウィンドウに以下のテキストが表示される事があります。 
 

[Program Memory](8 ビットまたは 16 ビットデバイス) ウィンドウを開くには、[Windows] > [Target Memory 
Views] > [Program Memory]を選択します。[Execution Memory](32 ビットデバイス) ウィンドウを開くには、

[Windows] > [Target Memory Views] > [Execution Memory]を選択します。 
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図 2-9 Program Memory - 単純なサンプルコード 
 

アドレス 0x330 に分岐命令があるため、コンパイラは while(1)のこの表現を生成しました。これはソースコー

ドと見なされないため、出力テキストが生成されます。 

2.7.2.3 プロジェクト ファイルごとのコードカバレッジ 
この単純なサンプルコードの場合、[Code Coverage]ウィンドウの割合はエディタ ウィンドウのカバレッジがあれ

ば支障なく確認できます。より複雑なアプリケーション (デモコード等)の場合、ファイルと関数ごとのカバレッジ

の内訳がテストとカバレッジを改善するための有益な情報を提供します。 

図 2-10 [Code Coverage]ウィンドウ - 単純なサンプルコード 
 

プロジェクト内の特定のファイルに関する目的のコードカバレッジを提供するために、ファイルのビルドプロパ

ティを変更できます。 

1. プロジェクト  ファイルを右クリックし、ドロップダウン  メニューから [Properties]を選択する。 [File 
Properties]ダイアログが表示される。 
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2. このダイアログで[Override build options]にチェックを入れる。ここで他のビルドオプションの選択内容が表

示される。[Code Coverage]をクリックする。 
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3. [Code Coverage instrumentation]オプションを[Disable]に変更して[OK]をクリックする。 

 
4. ファイル名が太字でプロジェクトに表示される。プロジェクトを実行して停止し、[Code Coverage]ウィン

ドウを確認する。ファイルがこのリストに表示されなくなる。エディタでファイルを開き、コードカバレッ

ジのハイライト表示が利用できない事を確認する 
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2.8 コードカバレッジ HTML レポートの作成 

コードカバレッジの情報をファイルに保存するには[Code Coverage]タブの[Generate HTML Report]ボタン  
をクリックします。 

カバレッジの色の詳細は 2.6.1.「ハイライト色」を参照してください。 
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図 2-11 ソースファイルのリストとカバレッジ 
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図 2-12 ソースファイルのリストとカバレッジの詳細 
 

 
 
2.9 MDB でのコードカバレッジに対するコマンドラインのサポート 

MDB を使うコマンドライン ツール用に MPLAB Code Coverage のサポートが追加されました。MDB でコードカバ

レッジ レポートを生成するには、以下の手順を実行します。 

• コードカバレッジ プロパティを有効にして ELF ファイルを生成する(2.5「コードカバレッジの有効化/無効

化」参照)。 
• レポートタイプ(html、gcov、all)を選択する(サンプルコードを参照)。 
• html レポートのパス(既定値: プロジェクトの保存場所)を提供する(サンプルコードを参照)。 
• レポートが存在する場合、replacehtmlreport を true に設定する(サンプルコードを参照)。 
• MDB を使って以下のサンプルを呼び出すと HTML レポートが生成される。 
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Device PIC16F886 
set xccodecoverage.reporttype html 
set xccodecoverage.htmlreportpath d:\report 
set xccodecoverage.replacehtmlreport true 
Hwtool SIM 
Program "d:\testCoverage.elf" 
Break main.c:41 
Run 
Wait 2000 
Quit 

サンプルコード 
 

コマンド オプションの詳細は『Microchip Debugger (MDB)ユーザガイド』(DS50002102)を参照してください。オ

ンラインヘルプは onlinedocs.microchip.com/で「Microchip Debugger」を検索すると見つかります。MDB ユーザガ

イドの PDF は、MPLAB X IDE のウェブページ(www.microchip.com/en-us/development-tools-tools-and-software/ 
mplab-x-ide)の[Documentation]タブにあります。 

https://onlinedocs.microchip.com/
https://www.microchip.com/en-us/development-tools-tools-and-software/mplab-x-ide
https://www.microchip.com/en-us/development-tools-tools-and-software/mplab-x-ide
https://www.microchip.com/en-us/development-tools-tools-and-software/mplab-x-ide


User Guide 50003236A_JP - p. 23 © 2022 Microchip Technology 
Inc. and its subsidiaries 

MISRA Check 
 

 

3. MISRA Check 
 
3.1 MISRA Check の概要 

MPLAB 解析ツールスイートの MPLAB® MISRA® Check 機能は MISRA (Motor Industry Software Reliability 
Association)が策定した一連の C コーディング規格です。MISRA ガイドラインは、安全でセキュアかつ移植可能で

信頼性の高い C コードを組み込みシステムで保証する上で役立ちます。 

MPLAB X IDE の[Tools]メニューから[MISRA Check]を実行すると、一連の MISRA ルールに対して静的コード解析

が行われます。MPLAB X IDE では、MISRA C:2012 ルールを使います。 

MISRA Check 機能は MPLAB X IDE v6.0 以降に含まれている解析ツールです。[AoU-04-MISRA]を参照してくださ

い。  

MPLAB 解析ツールスイートのライセンスには MISRA Check が含まれています(1.1「ライセンス」を参照)。[AoU-
08-MISRA]を参照してください。 

 
 

3.2 安全環境での MISRA Check の使用 
 

Attention: 安全環境で MPLAB 解析ツールスイートを使うには、機能安全バージョンの Microchip 社製

コンパイラを使う必要があります。MPLAB 解析ツールスイートをサポートするコンパイラの新しい機

能安全バージョンはまだ利用できない可能性があります。適切な機能安全コンパイラのライセンスは

www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-
safety を参照してください。 

• MPLAB XC8 機能安全ライセンス(MPLAB 解析ツールスイート サポート付き) 
• MPLAB XC16 機能安全ライセンス(MPLAB 解析ツールスイート サポート付き) 
• MPLAB XC32 機能安全ライセンス(MPLAB 解析ツールスイート サポート付き) 

 
MISRA Check は Microchip 社の開発ツールの標準プロセスに従って設計されています。Microchip 社は、システム

レベルで技術および機能安全要件を満たすためにツールに特定の AoU(使用前提条件)を主張します。AoU について

は以下で説明します。これらの AoU のいくつかは本書の他のセクションで言及されており、説明しているトピック

の一部として扱われています。 

システム インテグレータは本書に記載されている全ての AoU に対処し、MISRA Check で解析するアプリケーショ

ンに関わる全ての構成要素または事項がこれらの AoU を確実に遵守する責任を負います。 

システム インテグレータには以下の 2 つの選択肢があります。 

• 各前提条件を満たしている事を確認する 
• 前提条件を無視する 

どちらの場合も、システム インテグレータは、その前提条件を満たしている証拠、その前提条件を無視しても安全

要件に違反しない理由、または別の方法でその前提条件に十分に対処している方法の詳細な説明を提供します。 

Microchip 社がコンパイラの機能安全バージョンと共に提供した分類法文書に記載されているように、MISRA 
Check は TCL 1 に分類されます(推定ではないので注意してください)。この分類は、分類法文書に記載されている

使用前提条件とユースケースに基づいています。 

Note: MISRA Check は Microchip 社の開発ツールの標準プロセスに従って設計されています。Microchip 社は、シ

ステムレベルで技術および機能安全要件を満たすためにツールに特定の AoU(使用前提条件)を主張します。AoU に

ついては以下で説明します。これらの AoU のいくつかは本書の他のセクションで言及されており、説明しているト

ピックの一部として扱われています。最も重要な使用前提条件は、提示された結果の信頼性を高めるために MISRA 
Check を同タイプの別のツールまたは別の方法と照合しなければならない(例えば、この MISRA Check を別の独立

した MISRA Check と照合しなければならない)事です。 

https://www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-safety
https://www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-safety
https://www.microchip.com/en-us/solutions/functional-safety/mplab-development-ecosystem-for-functional-safety
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表 3-1 義務の程度 
 

Shall(当然の義務。～するものとする) Binding(拘束力がある) 

Should(義務に近い強い推奨。～すべきである) 推奨する解決策 
 

使用前提条件 説明 

[AoU-01-MISRA] 提示された結果の信頼性を高めるために MISRA Check を同タイプの別のツールまたは別の

方法と照合するものとする。 

[AoU-02-MISRA] MISRA Check は、サポートされている機能安全バージョンの MPLAB XC コンパイラと組み

合わせてのみ使うものとする。 

[AoU-03-MISRA] MISRA Check は真正な機能安全プロセスと組み合わせて使うものとする。 

[AoU-04-MISRA] MISRA Check は、MPLAB X IDE 文書で指定した対応プラットフォームにおいて MPLAB X 
IDE v6.0 以降の適合するバージョンで使うものとする。 

[AoU-05-MISRA] MISRA Check のユーザは有効なライセンスを有しているものとする。 

[AoU-06-MISRA] MISRA Check は、サポートされている Microchip 社製マイクロコントローラおよび DSC で

のみ使うものとする。 
[AoU-07-MISRA] 出力されるレポートが使用インターフェイスに基づいたものになるように、チェックする

ルールとファイル用に MISRA Check を適切に設定するものとする。 

[AoU-08-MISRA] MISRA Check は MPLAB X IDE v6.0 以降に同梱の Cpp Check ツールのみを使うものとす

る。 
 
 
3.3 MISRA Check の実行 

静的コード解析を実行する事で、ソースコードの潜在的な問題またはリスクのある構造を特定できます。 

 
MISRA Check の実行 
以下の指定内容に従って静的コード解析を実行します。 

• MISRA Check Main Project: ツールバー アイコン  をクリックするか、[Source]メニューから選択する。 
• MISRA Check Project: [Projects]ウィンドウでプロジェクト名を右クリックして選択する。 
• MISRA Check File: [Projects]ウィンドウでプロジェクト ファイルを右クリックして選択する。 
• Run MISRA Check each time project is rebuilt: ビルドの一部として有効にするには 

[Tools] > [Options] > [Embedded] > [MISRA Check] > [Run each time project is rebuilt]にチェックを入れる。 

 
静的コード解析の出力 
静的コード解析の結果は以下のいずれかの方法で出力できます。 

• [Output]ウィンドウ: [MISRA Check]タブの下にあります。 
• HTML レポートファイル: [Tools] > [Options] > [Embedded] > [MISRA Check]で有効にします。 
• CSV レポートファイル: [Tools] > [Options] > [Embedded] > [MISRA Check]で有効にします。 

ルール違反は、違反が見つかったファイル内の場所と[MISRA rule violated](ルール番号と説明)で識別されます。 

 
MISRA ルールの設定 
MISRA ルールの設定は[Tools] > [Options] > [Embedded] > [MISRA Check]にあります。 

 
コマンドラインからの MISRA Check 実行 
misracli.bat (Windows)または misracli.sh (Linux/Mac)は MISRA ルールチェック用のコマンドライン アプリ

ケーションです。3.5「MISRA Check のコマンドライン サポート」を参照してください。 
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3.4 MISRA Check のオプションタブ 
下図の[MISRA® Check]タブは以下の基準に対するアプリケーション コードのチェックをサポートしています。  

[MISRA Check]タブを開くには[Tools] > [Analysis] > [MISRA Check] > [MISRA Options]を選択します。 

 

上図のテーブルに全ての MISRA C:2012 ルールが表示されています。灰色表示されたルールは手動でチェックしま

す。適用されたルールを有効または無効にできます。 

表 3-2 MISRA Check のオプション 
 

オプション 説明 

Run each time project is 
rebuilt 

ビルドの一部として静的コード解析を実行する場合にチェックを入れます。 

Allow rule suppression 
with code comments 

コードでコメントされたルールを適用不可にします。 
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C:\Program 
Files\Microchip\MPLABX\[vX.XX]\mplab_platform\bin\misracli.bat 
–help 

...........続き 
オプション 説明 

Generate report files MISRA Check レポートを HTML または CSV 形式で生成する場合にチェックを入れま

す。レポートにはタイムスタンプが付きます。HTML または CSV レポートは<プロ

ジェクト フォルダ>\report に書き込まれます。また、プロジェクト ツリーに

[report]フォルダが追加され、そこからファイルを表示できます。HTML レポートは以

下の内容を表示します。 
• チェックを実行した時期 
• ルール違反 - 見つかった問題 
• チェックした内容 
• 適用したルール 

CVS レポートは以下の内容を表示します。 
• ルール違反 - 見つかった問題 

Use custom Cppcheck 
path 

MPLAB X IDE に含まれる Cppcheck をオーバーライドするために、カスタム

Cppcheck へのリンクを提供します。これを使って、適用したルールチェックを拡張/変
更/更新します。 

Additional Cppcheck 
arguments 

Cppcheck の追加の引数を提供します。 

 

3.5 MISRA Check のコマンドライン サポート 
MISRA Check のサポートはコマンドライン ツールとして利用できます。[AoU-07-MISRA]を参照してください。 

インストール 

• 最新の MPLAB X IDE をインストールします。 
• ネイティブのコマンド プロンプト(Windows、Linux、Mac のいずれか)を開き、MPLAB X IDE インストール

の bin フォルダに移動します。例: Windows: C:\Program Files\Microchip\MPLABX\v6.0\mplab_platform\bin 
• Misra Check コマンドライン ユーティリティが misracli.bat (Windows)または misracli.sh (Linux/Mac)と

して利用できます。 

例 

以下の例では Windows バージョンを使います(Linux/Mac の場合、misracli.bat の代わりに misracli.sh を使いま

す)。 
 

一般的な使い方: 

MISRA Check コマンドライン インターフェイスは既定値で全てのルールを有効にしますが、特定のルールを無効にす

るには–disable オプションを使います。 

MISRA Check コマンドライン インターフェイスの有効な全オプションの完全な一覧を表示するには、以下を実行しま

す。 
 

• misracli.bat myFile.c は 1 つのファイルに対して MISRA Check を実行し、出力にエラーを表示します。 
• misracli.bat myDirectory は、指定したディレクトリの下の全ての..c、.cpp、*.cxx、.cc、.h、 

.hpp、.hxx、*.hh ファイルに対して MISRA Check を再帰的に実行します。 
• misracli.bat は、エラーがない場合に 0 を、エラーが検出された場合に 0 以外の値を返します。 

特殊なオプション 

• misracli.bat --help は全てのオプションとその説明を表示します。 
• misracli.bat --version はバージョン番号を表示します。 
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MISRA Check 
 

 

• オプション--quiet を追加すると、警告とエラーが表示されます(例: ソースファイルがない、 
--cppcheck param の誤用)。 

• オプション--silent を追加すると、全ての出力が無効になります(ただし戻り値は正しいはずであり、レ

ポートと一緒に使用できます)。 

• オプション--workdir=myDirectory を使うと、現在の作業ディレクトリとは別のフォルダで解析が実行さ

れます。 
• オプション--cppcheck="C:\Program Files\myCustomCppCheckInstallation\cppcheck.exe"は、

ユーザがインストールした cppcheck.exe (cppcheck.sourceforge.iio/から入手可能)を使います。 

レポート: 

• オプション--html=myReport.html を追加すると、html レポートが生成されます。 
• オプション--csv=myReport.csv を追加すると、csv レポートが生成されます。 

ルールの処理: 

• オプション--disable="1.2 1.3"を追加すると、ファイルはチェックされるものの、ルール 1.2 および 1.3
のチェックが無効になります。 

• オプション--nosuppression を追加すると、ルールを適用不可にするインライン コードコメントが不許可

になります。 

https://cppcheck.sourceforge.io/
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改訂履歴 
 

 

4. 改訂履歴 
 
4.1 リビジョン A (2021 年 12 月) 

本書は初版です。 
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Microchip 社ウェブサイト 

Microchip 社はウェブサイト(www.microchip.com)を通してオンライン サポートを提供しています。当ウェブサイト

では、お客様に役立つ情報やファイルを簡単に見つけ出せます。以下を含む各種の情報をご覧になれます。 

• 製品サポート - データシートとエラッタ、アプリケーション ノートとサンプル プログラム、設計リソース、

ユーザガイドとハードウェア サポート文書、最新のソフトウェアと過去のソフトウェア 
• 技術サポート – FAQ(よく寄せられる質問)、技術サポートのご依頼、オンライン ディスカッション グループ、

Microchip 社のデザイン パートナー プログラムおよびメンバーリスト 
• ご注文とお問い合わせ - 製品セレクタと注文ガイド、最新プレスリリース、セミナー/イベントの一覧、お問い

合わせ先(営業所/正規代理店)の一覧 
 

製品変更通知サービス 
 

Microchip 社の製品変更通知サービスは、お客様に Microchip 社製品の最新情報をお届けする配信サービスです。ご

興味のある製品ファミリまたは開発ツールに関する変更、更新、リビジョン、エラッタ情報をいち早くメールにて

お知らせします。 

http://www.microchip.com/pcn にアクセスし、登録手続きをしてください。 
 

お客様サポート 
 

Microchip 社製品をお使いのお客様は、以下のチャンネルからサポートをご利用頂けます。 

• 正規代理店 
• 技術サポート 

サポートは正規代理店にお問い合わせください。各地の営業所もご利用になれます。本書の最後のページに各国の

営業所の一覧を記載しています。 

技術サポートは以下のウェブページからもご利用頂けます。www.microchip.com/support 

http://www.microchip.com/
http://www.microchip.com/pcn
http://www.microchip.com/support
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製品識別システム 
 

ご注文や製品の価格、納期につきましては正規代理店にお問い合わせください。 
 

製品番号 [X](1) - X /XX XXX 

デバイス テープ&リール  
オプション 

温度レンジ パッケージ パターン 

 

デバイス: PIC16F18313、PIC16LF18313、PIC16F18323、PIC16LF18323 

テープ&リール オプション: 空白 = 標準梱包(チューブまたはトレイ) 

T = テープ&リール(1) 

温度レンジ: I = -40～+85 ℃ (産業用温度レンジ) 

E = -40～+125 ℃ (拡張温度レンジ) 

パッケージ:(2) JQ = UQFN 

P = PDIP 

ST = TSSOP 

SL = SOIC-14 

SN = SOIC-8 

RF = UDFN 

パターン: QTP、SQTP、その他のコード等(または空白) 
 

例: 

• PIC16LF18313- I/P 産業用温度レンジ、PDIP パッケージ 
• PIC16F18313- E/SS 拡張温度レンジ、SSOP パッケージ 

Note: 
1. テープ＆リールの識別情報は、カタログの製品番号説明に記載しています。これは製品の注文時に使う識別

情報であり、デバイスのパッケージには印刷していません。テープ＆リールが選択できるパッケージの在庫/
供給状況は、Microchip 社正規代理店にお問い合わせください。 

2. 小型パッケージ オプションがご利用になれる場合があります。小型パッケージについては

www.microchip.com/packaging をご覧になるか、弊社正規代理店までお問い合わせください。 
 

Microchip 社のデバイスコード保護機能 
 

Microchip 社製品のコード保護機能について以下の点にご注意ください。 

• Microchip社製品は、該当するMicrochip 社データシートに記載の仕様を満たしています。 

• Microchip社では、通常の条件ならびに動作仕様書の仕様に従って使った場合、Microchip 社製品のセキュリティ レ
ベルは、現在市場に流通している同種製品の中でも最も高度であると考えています。 

• Microchip社はその知的財産権を重視し、積極的に保護しています。Microchip 社製品のコード保護機能の侵害は固

く禁じられており、デジタル ミレニアム著作権法に違反します。 

• Microchip社を含む全ての半導体メーカーで、自社のコードのセキュリティを完全に保証できる企業はありません。

コード保護機能とは、Microchip 社が製品を「解読不能」として保証するものではありません。コード保護機能は

常に進化しています。Microchip 社では、常に製品のコード保護機能の改善に取り組んでいます。 

 

http://www.microchip.com/packaging
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法律上の注意点 
 

本書および本書に記載されている情報は、Microchip 社製品を設計、テスト、お客様のアプリケーションと統合する目

的を含め、Microchip 社製品に対してのみ使う事ができます。それ以外の方法でこの情報を使う事はこれらの条項に違

反します。デバイス アプリケーションの情報は、ユーザの便宜のためにのみ提供されるものであり、更新によって変

更となる事があります。お客様のアプリケーションが仕様を満たす事を保証する責任は、お客様にあります。その他

のサポートはMicrochip 社正規代理店にお問い合わせ頂くか、https://www.microchip.com/en-us/support/design-
help/client-support-servicesをご覧ください。 

Microchip 社は本書の情報を「現状のまま」で提供しています。Microchip 社は明示的、暗黙的、書面、口頭、法定の

いずれであるかを問わず、本書に記載されている情報に関して、非侵害性、商品性、特定目的への適合性の暗黙的保

証、または状態、品質、性能に関する保証をはじめとするいかなる類の表明も保証も行いません。 

いかなる場合もMicrochip 社は、本情報またはその使用に関連する間接的、特殊的、懲罰的、偶発的または必然的損失、

損害、費用、経費のいかんにかかわらず、またMicrochip 社がそのような損害が生じる可能性について報告を受けてい

た場合あるいは損害が予測可能であった場合でも、一切の責任を負いません。法律で認められる最大限の範囲を適用

しようとも、本情報またはその使用に関連する一切の申し立てに対するMicrochip 社の責任限度額は、使用者が当該情

報に関連してMicrochip 社に直接支払った額を超えません。 

Microchip 社の明示的な書面による承認なしに、生命維持装置あるいは生命安全用途にMicrochip社の製品を使う事は

全て購入者のリスクとし、また購入者はこれによって発生したあらゆる損害、クレーム、訴訟、費用に関して、

Microchip 社は擁護され、免責され、損害をうけない事に同意するものとします。特に明記しない場合、暗黙的あるい

は明示的を問わず、Microchip社が知的財産権を保有しているライセンスは一切譲渡されません。 
 

商標 
 

Microchip 社の名称とロゴ、Microchip ロゴ、Adaptec、AVR、AVRロゴ、AVR Freaks、BesTime、BitCloud、
CryptoMemory、CryptoRF、dsPIC、flexPWR、HELDO、IGLOO、JukeBlox、KeeLoq、Kleer、LANCheck、LinkMD、

maXStylus、maXTouch、MediaLB、megaAVR、Microsemi、Microsemi ロゴ、MOST、MOST ロゴ、MPLAB、

OptoLyzer 、 PIC 、 picoPower 、 PICSTART 、 PIC32 ロゴ、 PolarFire 、 Prochip Designer 、 QTouch 、 SAM-BA 、

SenGenuity、SpyNIC、SST、SST ロゴ、SuperFlash、Symmetricom、SyncServer、Tachyon、TimeSource、tinyAVR、

UNI/O、Vectron、XMEGA は米国とその他の国におけるMicrochip TechnologyIncorporated の登録商標です。 

AgileSwitch、APT、ClockWorks、The Embedded Control SolutionsCompany、EtherSynch、Flashtec、Hyper Speed 
Control、HyperLightLoad、Libero、motorBench、mTouch、Powermite 3、Precision Edge、ProASIC、ProASIC Plus、
ProASIC Plus ロゴ、Quiet-Wire、SmartFusion、SyncWorld、Temux、TimeCesium、TimeHub、TimePictra、

TimeProvider、TrueTime、ZL は米国におけるMicrochip Technology Incorporated の登録商標です。 

Adjacent Key Suppression 、 AKS 、 Analog-for-the-Digital Age 、 Any Capacitor 、 AnyIn 、 AnyOut 、 Augmented 
Switching 、 BlueSky 、 BodyCom 、 Clockstudio 、 CodeGuard 、 CryptoAuthentication 、 CryptoAutomotive 、

CryptoCompanion、CryptoController、dsPICDEM、dsPICDEM.net、Dynamic Average Matching、DAM、ECAN、

Espresso T1S、EtherGREEN、GridTime、IdealBridge、In-Circuit Serial Programming、ICSP、INICnet、Intelligent 
Paralleling、 IntelliMOS、Inter-Chip Connectivity、JitterBlocker、Knob-on-Display、KoD、maxCrypto、maxView、

memBrain、Mindi、MiWi、MPASM、MPF、MPLAB Certified ロゴ、MPLIB、MPLINK、MultiTRAK、NetDetach、
Omniscient Code Generation、PICDEM、PICDEM.net、PICkit、PICtail、PowerSmart、PureSilicon、QMatrix、REAL 
ICE 、 RippleBlocker 、 RTAX 、 RTG4 、 SAM-ICE 、 Serial Quad I/O 、 simpleMAP 、 SimpliPHY 、 SmartBuffer 、
SmartHLS 、 SMART-I.S. 、 storClad 、 SQI 、 SuperSwitcher 、 SuperSwitcher II 、 Switchtec 、 SynchroPHY 、

TotalEndurance、Trusted Time、TSHARC、USBCheck、VariSense、VectorBlox、VeriPHY、ViewSpan、WiperLock、
XpressConnect、ZENAは米国とその他の国におけるMicrochip Technology Incorporated の商標です。 

SQTP は米国におけるMicrochip Technology Incorporated のサービスマークです。 

Adaptec ロゴ、Frequency on Demand、Silicon Storage Technology、Symmcom はその他の国におけるMicrochip 
Technology Incorporatedの登録商標です。 

GestIC は、その他の国におけるMicrochip Technology Germany II GmbH & Co. KG (Microchip Technology 
Incorporated の子会社) の登録商標です。 

その他の商標は各社に帰属します。 

https://www.microchip.com/en-us/support/design-help/client-supportservices
https://www.microchip.com/en-us/support/design-help/client-supportservices
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品質管理システム 
 

Microchip社の品質管理システムについてはwww.microchip.com/qualityをご覧ください。 

 

http://www.microchip.com/quality
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各国の営業所とサービス 
 

 

南北アメリカ アジア/太平洋 アジア/太平洋 欧州 

本社 
2355 West Chandler Blvd. 
Chandler, AZ 85224-6199 
Tel: 480-792-7200 
Fax: 480-792-7277 
技術サポート: 
http://www.microchip.com/support 
URL: 
www.microchip.com 
アトランタ 
Duluth, GA 
Tel: 678-957-9614 
Fax: 678-957-1455 
オースティン、TX 
Tel: 512-257-3370 
ボストン 
Westborough, MA 
Tel: 774-760-0087 
Fax: 774-760-0088 
シカゴ 
Itasca, IL 
Tel: 630-285-0071 
Fax: 630-285-0075 
ダラス 
Addison, TX 
Tel: 972-818-7423 
Fax: 972-818-2924 
デトロイト 
Novi, MI 
Tel: 248-848-4000 
ヒューストン、TX 
Tel: 281-894-5983 
インディアナポリス 
Noblesville, IN 
Tel: 317-773-8323 
Fax: 317-773-5453 
Tel: 317-536-2380 
ロサンゼルス 
Mission Viejo, CA 
Tel: 949-462-9523 
Fax: 949-462-9608 
Tel: 951-273-7800 
ローリー、NC 
Tel: 919-844-7510 
ニューヨーク、NY 
Tel: 631-435-6000 
サンノゼ、CA 
Tel: 408-735-9110 
Tel: 408-436-4270 
カナダ - トロント 
Tel: 905-695-1980 
Fax: 905-695-2078 

オーストラリア - シドニー 
Tel: 61-2-9868-6733 
中国 - 北京 
Tel: 86-10 -8569-7000 
中国 - 成都 
Tel: 86-28-8665-5511 
中国 - 重慶 
Tel: 86-23-8980-9588 
中国 - 東莞 
Tel: 86-769-8702-9880 
中国 - 広州 
Tel: 86-20-8755-8029 
中国 - 杭州 
Tel: 86-571-8792-8115 
中国 - 香港SAR 
Tel: 852-2943-5100 
中国 - 南京 
Tel: 86-25-8473-2460 
中国 - 青島 
Tel: 86-532-8502-7355 
中国 - 上海 
Tel: 86-21-3326-8000 
中国 - 瀋陽 
Tel: 86-24-2334-2829 
中国 - 深圳 
Tel: 86-755-8864-2200 
中国 - 蘇州 
Tel: 86-186-6233-1526 
中国 - 武漢 
Tel: 86-27-5980-5300 
中国 - 西安 
Tel: 86-29-8833-7252 
中国 - 厦門 
Tel: 86-592-2388138 
中国 - 珠海 
Tel: 86-756-3210040 

インド - バンガロール 
Tel: 91-80-3090-4444 
インド - ニューデリー 
Tel: 91-11-4160-8631 
インド - プネ 
Tel: 91-20-4121-0141 
日本 - 大阪 
Tel: 81-6-6152-7160 
日本 - 東京 
Tel: 81-3-6880-3770 
韓国 - 大邱 
Tel: 82-53-744-4301 
韓国 - ソウル 
Tel: 82-2-554-7200 
マレーシア - クアラルンプール 
Tel: 60-3-7651-7906 
マレーシア - ペナン 
Tel: 60-4-227-8870 
フィリピン - マニラ 
Tel: 63-2-634-9065 
シンガポール 
Tel: 65-6334-8870 
台湾 - 新竹 
Tel: 886-3-577-8366 
台湾 - 高雄 
Tel: 886-7-213-7830 
台湾 - 台北 
Tel: 886-2-2508-8600 
タイ - バンコク 
Tel: 66-2-694-1351 
ベトナム - ホーチミン 
Tel: 84-28-5448-2100 

オーストリア - ヴェルス 
Tel: 43-7242-2244-39 
Fax: 43-7242-2244-393 
デンマーク - コペンハーゲン 
Tel: 45-4485-5910 
Fax: 45-4485-2829 
フィンランド - エスポー 
Tel: 358-9-4520-820 
フランス - パリ 
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79 
ドイツ - ガーヒンク 
Tel: 49-8931-9700 
ドイツ - ハーン 
Tel: 49-2129-3766400 
ドイツ - ハイルブロン 
Tel: 49-7131-72400 
ドイツ - カールスルーエ 
Tel: 49-721-625370 
ドイツ - ミュンヘン 
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44 
ドイツ - ローゼンハイム 
Tel: 49-8031-354-560 
イスラエル - ラーナナ 
Tel: 972-9-744-7705 
イタリア - ミラノ 
Tel: 39-0331-742611 
Fax: 39-0331-466781 
イタリア - パドヴァ 
Tel: 39-049-7625286 
オランダ - ドリューネン 
Tel: 31-416-690399 
Fax: 31-416-690340 
ノルウェー - トロンハイム 
Tel: 47-7288-4388 
ポーランド - ワルシャワ 
Tel: 48-22-3325737 
ルーマニア - ブカレスト 
Tel: 40-21-407-87-50 
スペイン - マドリッド 
Tel: 34-91-708-08-90 
Fax: 34-91-708-08-91 
スウェーデン - ヨーテボリ 
Tel: 46-31-704-60-40 
スウェーデン - ストックホルム 
Tel: 46-8-5090-4654 
イギリス - ウォーキンガム 
Tel: 44-118-921-5800 
Fax: 44-118-921-5820 

 
 

http://www.microchip.com/support
http://www.microchip.com/

